
        SimJack    Help    Contents
Welcome!    This help facility is set up in two sections.    The first section goes into the 
details of the application itself.    The second section contains tutorials for beginners as well 
as for experts.    

SimJack Menus
Game Menu
Edit Menu
View Menu
Options Menu
Actions Menu
Special Menu

SimJack Tutorials
Playing the Game
The Basic Strategy
The Simple Count
The Complex Count



Game Menu Hot Key(s)
New                  Ctl+N

Open      Ctl+O
Save      Ctl+S
Save As
Exit Alt+F4

The Game Menu includes commands that enable you to open and save game 
parameters.    The game parameters consist of the Advice Parameters, Rules of 
the Table, and the Shoe Parameters.    Saving the game parameters is useful when
changes have been made and you want to save the game parameters to disk.    When
you are saving or opening game parameter files, keep in mind that they have the 
extension of .SJP .    Also, you can include a game parameter file as a command line 
argument when you first run the program .    The file is specified through the Program 
Manager's Properties command under the File Menu.



The New command loads the default set of game parameters, shuffles the shoe, and 
resets your worth to $200.00.    If the current set has been changed, then you will be 
prompted to save the changes.



The Open command loads an existing set of game parameters, shuffles the shoe, 
and resets your worth to $200.00.    If the current set has been changed, then you will
be prompted to save the changes.



The Save command stores the current set of game parameters to disk.    If the 
current set has not been named, then you will be prompted for the new name.



The Save As command stores the current set of game parameters to disk with a new
name.    You will be prompted for the new name.



The Exit command quits the game.    If the current set of game parameters have 
been changed, then you will be prompted to save the changes.



Edit Menu Hot Key(s)
Advice Ctl+A

Advice Tables
Count Advice Button

Rules Ctl+R
Allowable Splits
Allowable Double Downs
Dealer Hits Soft 17
Surrender Allowed
Insurance Allowed

Shoe Ctl+H
Shuffle Accuracy
Cut Accuracy
Shuffle Iteration
Shoe Size

The Edit Menu includes three commands that enable you to modify the current set 
of game parameters.    Each command invokes their respective dialog box enabling 
the modifications.    The changes may be saved to disk using the Save command 
under the Game Menu.



Edit Menu
Advice

The Advice command initiates the Advice Parameters dialog box.    This dialog box 
enables you to alter what the Advice Box displays in its window .    The Advice 
Parameters dialog box's primary components are the Advice Tables and the Count 
Advice button.    Even though the main purpose of this dialog box is to alter what the 
Advice Box displays, it also serves as your reference for learning the appropriate 
actions in the various circumstances.



Edit Menu
Advice

Advice Tables

The Advice Tables enable you to alter what is displayed in the Advice Box.    For 
instance, if the Hard Hit Table says to hit in a particular situation (the box is 
checked), then the Advice Box will instruct you to "Hit".    Even though these tables 
are user defined, it is highly recommended that they conform to the tables defined by
The Basic Strategy.    The rows are dependent on your hand whereas the columns 
are dependent upon on the dealer's up card.    For example, say that you're looking at
the Hard Hit Table.    The situation is such that you have a 10 and a 9 (a hard 19) and 
the dealer is showing a Queen (10).    Now, look where the "19" row intersects the 
"10" column; if the box is checked, then you should hit and if it isn't, then stand.    
Remember that these tables are user defined so it is indeterminate whether the box 
is checked or not.    However, it certainly should not be checked since it would be 
absurd to hit a hard 19!

As a final note, the advice in the Advice Box is always given in accordance with the 
rules of the table.    The Rules of the Table dialog box can be accessed through the 
Rules command under the Edit Menu.    For instance, say that you have a 5 and an 
Ace (a Soft 16) and the dealer is showing a 6.    Furthermore the Soft Double Down 
Table instructs you to indeed double down in this situation (the box is checked).    The
Advice Box will only display "Double Down" if a 16 is an Allowable Double Down.



Edit Menu
Advice

Count Advice

The Count Advice button initiates the Count Advice Parameters dialog box that 
enables you to further modify what is displayed within the Advice Box.    However, 
this enhanced advice will only be seen in the Advice Box if the Card Count box is 
checked in the Advice Box.    Take note that the advice in the Count Advice 
Parameters dialog box is user defined; yet, it should be defined in accordance to a 
tried and true strategy such as the    Simple Count.

The Count Advice Parameters dialog box contains two types of editable advice, 
the card count Advice Tables and the Betting Advice edit boxes.    It also contains 
the Use Adjusted Count check box as well as the    Card Values button.



Edit Menu
Advice

Count Advice
Advice Tables

The card count Advice Tables are extensions to the regular Advice Tables in that 
they override the regular Advice Tables based upon the current card count.    For 
instance, say that the Card Count box is checked in the Advice Box.    Furthermore, 
the current card count is 10 (for instance); also, you are holding a hard 16 against a 
dealer Queen.    Suppose that the regular Hard Hit Table instructs you to hit on 16 
against a 10 (the box is checked).    Also, the card count Hard Hit Table says to hit 
only when the count is < 1.    In this scenario, the Advice Box will instruct you to 
"Stand".    See, the card count Hard Hit Table overrode the regular Hard Hit Table 
since the card count was not less than 1. 

 As a final note, the entries on the card count Advice Tables may be left blank.    If 
this is the case, then there is no override and the advice will be based solely on the 
regular Advice Tables.



Edit Menu
Advice

Count Advice
Card Values

The Card Values button initiates the Card Values dialog box.    This box specifies 
the card count value of each card.    For instance, if you are adhering to the Simple 
Count, then the value associated with cards 2 - 7 is one, the value of 8 and 9 is zero, 
the value of ten cards is minus one, and Aces are valued at minus two. 

However, if you plan on experimenting with the Complex Count, then you will need 
to modify the card's values in accordance with this superior game strategy.    That is, 
the 2 and 3 cards are associated with two, 4 is associated with two and a half, and so 
forth...

Or, you can test your own strategy.    For instance, many people feel that an Ace 
should not take on the value of such a large negative number (-2 or -3).    See, large 
cards assume negative values; yet, Aces can also assume a small card.    With this in 
mind, you can set an Ace at 0 or 1 (for instance) and then test your strategy by 
running the simulation a few thousand times.



Edit Menu
Advice

Count Advice
Use Adjusted Count

The Use Adjusted Count box determines whether the card count is adjusted with 
respect to the cards remaining in the shoe.    If this box is checked, then the Advice 
Box will specify that the count is adjusted.    And, since game simulation runs off the 
advice given in the Advice Box, simulated play will also utilize the adjusted card 
count.

The adjusted count is calculated by multiplying the count by 100 and then dividing it 
by number    of cards remaining in the shoe.    That is:

Adjusted                                          Count times 100
      Count            =  ----------------------------------------------
                                            number of cards remaining in shoe

As we have seen before, a large count is beneficial to you; furthermore, a large count 
is even more beneficial to you if you know that there are just a few cards remaining 
in the shoe.    Hence, the purpose of adjusting the count.    See, when the shoe is 
fresh, the count does not fluctuate rapidly since the number of cards remaining in the
shoe (the denominator) is large.    However, when there are just a few cards 
remaining in the shoe, the count is magnified either in the positive or the negative 
direction.    This is due to the fact that the denominator (the number of cards 
remaining in the shoe) becomes small.

The Simple Count does not mandate the use of an adjusted count.    Nonetheless, it 
certainly can be used to improve the    strategy.    If you do use an adjusted count with
the Simple Count, then you should edit    the values contained in the advice edit 
boxes to capitalize on the modified count.    Generally speaking, the new advice will 
be a hybrid between the Simple Count advice and Complex Count advice.

The Complex Count, on the other hand,    requires you to adjust the count .    So, if you
plan on experimenting with the Complex Count, make certain that the Use Adjusted
Count check box is indeed checked.



Edit Menu
Advice

Count Advice
Betting Advice

To be an affective player, you need to fluctuate your bet according to the card count.  
Generally speaking, you should increase your bet as the count rises.    For example, 
say that the Betting Advice instructs you to bet 2 units when the count is >4.    Also,
suppose that the shoe has just been shuffled and that you place a bet of $5.00.    This
initial bet becomes your base bet and is considered to be 1 unit.    Now, you should 
maintain betting 1 unit ($5.00) until the card count is greater than 4.    Once the card 
count surpasses 4, then you should bet 2 Units ($10.00).    Again, a unit is based upon
your first bet on a fresh shoe.    Each time that the shoe is shuffled, you have the 
opportunity to alter what is considered to be 1 unit by simply altering you initial bet.

When you take insurance, you are insuring against a dealer blackjack.    Remember, 
you can only insure when the dealer is showing an Ace.    So basically you insuring 
against a hole card of 10.    Hence, you should take insurance only if there is an 
excess of ten cards (a high card count).    Now, say that the Betting Advice instructs 
you to take insurance only when the count is > 5.    Simply stated, this says to take 
insurance only when the card count is greater than 5 and refuse the insurance if it is 
4 or less.
is checked!



Edit Menu
Rules

The Rules command initiates the Rules of the Table dialog box.    Simply stated, 
this dialog box enables you to modify the rules of the table.    The rules of the table 
consist of the, Allowable Splits, Allowable Double Downs, Dealer Hits Soft 17, 
Surrender Allowed, Insurance Allowed.



The set of check boxes named Allowable Splits specify which hands may be split.    
All of the available choices consist of a hands that contain two, and only two, cards of
the same face value.    Virtually all casinos will permit you to split any hand consisting
of two cards of the same value.

The A,A : 1 Card Each check box specifies how split Aces are dealt with.    If this box 
is checked and you split two Aces, then each split Ace will receive one, and only one, 
card.    Of course, you want those cards to be 10's (to make 21's).    Yet, they may not 
be 10's; hence, it is to your advantage to make the decision to stand (or continue) 
after the card is dealt to a split Ace.    Unfortunately, more and more casinos are 
requiring their guests to abide by this annoying rule.

The Maximum Splits edit box specifies how many times you can repetitively split.    
Keep in mind, that you are still restricted to splitting in accordance to the fore 
mentioned Allowable Splits.    For example, say you split two Aces and the first card 
dealt to one of the split hands is also an Ace.    In this case, you may split again if you 
have not exceeded the Maximum Splits.



The set of check boxes named Allowable Double Downs specify the hands that you
can double down.    Most casinos permit you to double down only on ten's and 
eleven's.    Yet, some will also permit you to double down on eight's and nine's.    Very 
few will permit double downs on any hand.



Simply, if the Dealer Hits on Soft 17 boolean is set, then he will hit on a soft 17.    
For example, the dealer must hit a 6 and an Ace when this boolean is set.    Generally,
most casinos force the dealer to hit a soft 17; however, it is to the player's advantage
if the dealer stands on a soft 17.



If the Surrender Allowed check box is set, then you may surrender immediately 
after the deal.    For example, if you have a 16 and the dealer has a 10 card showing, 
then you may want to surrender the hand and take back exactly one half of your bet   
Generally, most casinos do not allow surrender; however, it is to the player's 
advantage if it is offered.



If the Insurance Allowed check box is set, then you may insure against a dealer 
blackjack.    You can only insure immediately after the deal and if the dealer's up card 
is an Ace.    Generally, most casinos offer insurance.



Edit Menu
Shoe

The Shoe command initiates the Shoe Parameters dialog box.    This dialog box 
enables you to modify the Shuffle Accuracy, Cut Accuracy, Shuffle Iteration, 
Shoe Size



The Shuffle Accuracy specifies how the dealer meshes cards together during a 
shuffle.    When the dealer shuffles, he first cuts the shoe into two sub-shoes.    Then, 
he meshes the two sub-decks back into one shoe.    If the Shuffle Accuracy is set to 
perfect, then the sequence of the resulting shoe will be 1,2,1,2,1,2,1,2,1,2,1..., where 
1 represents a card from one sub-shoe and 2 represents a card from the other.    It is 
recommended that the Shuffle Accuracy be set to less than perfect to promote better
randomness of the shuffle.      



The Cut Accuracy specifies how the dealer cuts the shoe into two sub-shoes prior to 
shuffling.    If the Cut Accuracy is set to perfect, then the shoe is divided exactly in 
half.    It is recommended that the Cut Accuracy be set to less than perfect to promote
better randomness of the shuffle.



The Shuffle Iteration specifies how many times the dealer shuffles the shoe 
between rounds.    It is recommended that the Shuffle Iteration be set to at least two.  
This promotes better shoe randomness.



The Shoe Size specifies how many decks make up a shoe.    Shoe sizes can range 
from a single deck to a maximum of six decks.    In general, a smaller shoe favors the 
player; however, constantly stopping to split the shoe can be annoying.



View Menu
File Toolbar
Options Toolbar
Actions Toolbar
Status Bar

The View Menu includes commands that enable you to display the application's 
additional visual aides.    The detachable toolbars are located at the top of the 
window, directly below the Menu bar.    Incidentally, each of the three toolbars can be 
detached by simply dragging the bar from the top.    Further, each of the bars can be 
docked on either side of the window.    The Status Bar is located at the bottom of the 
window.



Checking the File Toolbar command will display the first detachable toolbar. 



Checking the Options Toolbar command will display the second detachable toolbar. 



Checking the Actions Toolbar command will display the third detachable toolbar. 



Checking the Status Bar command displays the Status Bar that is at the bottom of 
the main window.    Keeping the Status Bar open is optional since the information it 
provides is not crucial to the game.



Options Menu Hot Key(s)
Surrender         U

Split       P
Double Down              B
Insure   I

The Options Menu includes four commands that enable you execute the various 
blackjack options.    All of these options are provided on the Options Toolbar to speed 
game play.



The Surrender command forfeits the current hand in exchange for one half of your 
initial bet.    This is useful when you've been dealt a stiff hand (12 - 16) and the dealer
holds a pat card (a 7 or more).    For example, if you have a 16 and the dealer has a 
10 card showing, then you may want to surrender the hand and take back exactly 
one half of your bet.    After all, losing half your bet is better than all of your bet!



The Split command splits the current hand forming two separate hands.    The hand 
must consist of two, and only two, cards that have the same face value.    A bet equal 
to the initial bet is then placed on the new hand.    You can also repetitively split.    For 
example, say you split two Aces and the first card dealt to one of the split hands is 
also an Ace.    In this case, you may split again!



The Double Down command doubles the initial bet.    However, the dealer requires 
you to draw one, and only one, card after doubling down.    For example, say you have
a 7 & 4 (a hard 11) and the dealer's up card is a 6.    You may want to double down in 
this situation hoping that the next card dealt is a 10 (or the dealer busts).    Since the 
situation is in your favor, why not double the bet and win twice as much! 



The Insurance command allows you to insure against a dealer blackjack.    You can 
only insure immediately after the deal and if the dealer's up card is an Ace.    Taking 
insurance costs exactly one half of your initial bet but pays two to one if the dealer 
does indeed have blackjack.

Successfully taking insurance when you do not have blackjack results in keeping your
bet.    You lose your initial bet but because insurance pays two to one, the net result 
appears as if you retain your bet.

Taking insurance when you do have blackjack results in doubling your initial bet.    If 
the dealer has blackjack, then you push the dealer, insurance pays two to one, but 
the cost of insurance is deducted from the winnings.    The net result is doubling your 
bet.    On the other hand, if the dealer does not have blackjack, then your initial bet 
gets paid three to two, the insurance does not get paid off, but the cost of insurance 
is still deducted from the winnings.    The net result is doubling your bet.    Hence, 
taking insurance when you have blackjack is the same as winning even money.



Actions Menu Hot Key(s)
     Bet

Bet $1 1
Bet $5 5
Bet $25 2
Last Bet      L    or    Space Bar
Deal D
Hit H
Stand S    or    Right Mouse Click

The Actions Menu contains commands which allow you to navigate through your 
game.    Thus, this is your mechanism to win gobs of dough.    From this menu you can
make the decision to bet, deal, hit, and stand.



The Bet $1 command allows you to wager a single dollar.    Still, if you have second 
thoughts about placing such a large wager, you can take back your bet by clicking on
the placed bet. 



The Bet $5 command allows you to wager five bucks.    The bet can be taken back by
clicking on the placed bet



The Bet $25 command allows you to wager twenty-five bucks. If you have second 
thoughts about placing such a large wager, you can take back your bet by clicking on
the placed bet.    As you can probably guess, this is the fastest way to get to the 
maximum bet of $200.



The Last Bet command allows you to wager whatever your last bet was.    This way 
you don't always have to be clicking on the chips!    This command is initiated either 
by hitting L or by hitting the Space Bar.    Keep in mind that this command not only 
places your last bet, it also initiates the dealing process.    Hence, you'll have no time 
to take back your bet once you’ve initiated the command! 



The Deal command begins the round.    It's kind of like telling the dealer that you're 
ready to win some money.    After the cards are dealt, the dealer will wait for you to 
hit, stand, or try one of the special options.



The Hit command allows you to receive another card.    You'll need to use this when 
you've been dealt a small  hand and need to get a bit closer to twenty-one.    But 
don't hit too many times!



The Stand command ceases play and passes control to the dealer.    He'll then draw 
cards to his hand, if appropriate, then settle up the bets.    This command is initiated 
either by hitting S or by hitting the Right Mouse Click.    Good luck!



Special Menu Hot Key(s)
Advice Box Ctl+V

Card Count
Enforce.

Simulation Box Ctl+M
Initial Amount
Final Amount
Rounds Dealt
Rounds to Deal
Base Bet
Display

The Special Menu contains the Advice Box and Simulation Box commands.    The 
Advice Box issues action recommendations based upon the current table scenario.    
The Simulation Box    provides for rapid automated play based upon the Advice Box.



Special Menu
Advice Box

The Advice Box command on the Special Menu displays the Advice Box dialog.    
The advice is dependent on the current cards on the table and is in the format of 
"Hit", "Stand", "Double Down", and so forth.    The advice is established by the user 
defined Advice Tables accessible through the Advice command on the Edit Menu.

The Advice Box contains the Card Count and the    Enforce check boxes.    The 
state of these commands are retained even after the Advice Box has been closed.    
For instance, if the Card Count command is checked upon closing the Advice Box, 
then it will be checked upon re-opening the box.    Likewise, the Enforce command 
operates in the same fashion.



The Card Count check box in the Advice Box enhances the advice format in the 
box by utilizing the card count.    The first line in the window displays the advice 
based upon the card count and the second line displays the current card count.    
Keep in mind that the states of these check boxes are retained even after closing the 
Advice Box.    This is significant if you plan on using the Simulation Box.    See, 
simulated play runs off of the advice given in the Advice Box.    Hence, the state of 
the Card Count check box is significant even after the box closes.



The Enforce check box requires you to take the action that the Advice Box 
suggests.    If you attempt to defy the advice then a beep will sound and the action 
will not be executed.    This can be very helpful as a learning tool since you will not be
able to make a wrong action.    Furthermore, the enforcement continues even after 
the box has been closed.    This can also be useful if you want to play the game 
without the assistance of the Advice Box but still want to be sure you don't make an 
ill advised action.



Special Menu
Simulation Box

The Simulation Box is a dialog box that enables you to simulate game play.    
Simulating game play entails automating actions such that you have no control of 
whether to hit, stand, double down, etc.    However, each decision is made in 
accordance to what the Advice Box displays.    But remember, the Advice Box 
depends on the user defined advice accessible through the Advice command on the 
Advice Menu.    Now, if you run the simulation for long runs, what you are actually 
doing is validating whether the current advice is sound or not.    This enables you to 
skillfully tailor the advice to your satisfaction!

The items contained in the Simulation Box include the Initial Amount, the Final 
Amount, and the Rounds Dealt.    It also contains the Rounds to Deal, the Base 
Bet edit boxes as well as the Display check box.



The Initial Amount displays your worth prior to starting the automated simulation.



The Final Amount displays your worth after the automated simulation has ended.



The Rounds Dealt displays how many rounds that have been automatically dealt.    
This is updated as the simulation runs.



The Rounds to Deal edit box allows you to define how many rounds the simulation 
will deal.    The maximum amount of rounds is 99,999.



 The Base Bet edit box allows you to define the amount bet each round.    If the Card
Count check box in the Advice Box has been checked, then the bet will be varied as
defined by the Betting Advice.    However, if it has not been checked, then the bet 
will remain constant.    

Keep in mind that    this variable only comes into play on the first bet on a fresh shoe. 
See,    all of the remaining bets are based on the first bet, the base bet (1 unit).    With
this in mind, a change of    this variable will not affect the recommended bet until the 
shoe runs out and is shuffled again.



The Display check box allows you to specify whether the actions are shown or if the 
actions are hidden.    Displaying the actions allows you to watch how the game is 
transpiring.    However, suppressing the display allows for rapid simulation.



Playing the Game

The purpose of the game is to get to twenty one.    You play successive rounds 
against the house (the dealer).    And, at the end of each round, the winner is the one 
who is closest without going over twenty one.    You may request as many cards as 
you wish provided that you do not exceed twenty one.    After you have received all 
the cards that you wish, you stand and the dealer takes over.    The dealer must draw 
additional cards until he has seventeen or higher.    The player gets paid off at two to 
one if he wins.    That is, the player wins two units for every one unit that is bet.    
However, he forfeits his bet if he loses.

Cards 2 through 10 have a value equal to their face value.    Face cards have a 
value of 10.    Aces count as either 1 or 11.    Since Aces can represent two values, it is
possible for a hand to have two values.    For instance, a six and an Ace can either be 
7 or 17; this is referred to as a 'soft 17'.      A hard hand has only one possible value.    
For instance, a seven and a ten is a 'hard' 17.

The first thing to do when you sit down at the blackjack table is to place an 
initial bet.    Click on a chip to place the bet.    After the bet is made, click on the shoe 
and the dealer will deal two cards to you and two cards to himself.    You are only 
allowed to see one of the dealer's cards.    Next, you have to decide if you want to hit;
that is, if you want another card.    Click on your hand to hit your hand.    If you are 
satisfied with what you have, then stand by clicking on the dealer's hand.    The 
dealer draws the appropriate cards for himself and then settles the wagers.    Click on 
a chip to start the cycle over again.



The Basic Strategy

The Basic Strategy is a superior playing strategy that was developed by Edward O. 
Thorp.    The strategy uses statistical analysis to determine appropriate actions.    This 
method is very mechanical since the advice is only contingent upon the dealer's up 
card and the value of your hand.    This advice can be concisely condensed into a 
series of tables.    The following table describes the appropriate hits when you're 
holding a hard hand against a dealer's up card.    Remember, a hard hand contains no
Aces that are assuming the value of 11.    For instance, a 10 and a 7 is a hard 17; 
likewise, a 10, 6, and an Ace is also a hard 17.    In both cases there are no Aces 
assuming the value of 11.

So, if you're holding a hard hand with the value of 11 (or less), then the table says to hit 
regardless of what the dealer's up card is.    However, if you're holding a hard 16 against a 
dealer's 6, then the table says to stand.

If you are holding a soft hand, then the advice becomes very straight forward as described 
by the following table.    Remember, a soft hand contains an Ace that is assuming the value 
of 11.    For instance, a hand consisting of a 6 and an Ace is referred to as a soft 17 (or hard 
7).    The following table describes the appropriate hits when you're holding such a hand.

So, if you're holding a soft hand with the value of 17 (or less), then the table says to hit 
regardless of what the dealer's up card is.    Likewise, if you're holding a soft 18 against a 
dealer's 9, 10, or Ace, then the table says to hit.    You should stand on soft 19's and higher 
simply because these are rather good hands.

Advice tables can also be used to specify when to double down on hard hands.    Remember, 
doubling down entails doubling your bet and then receiving one, and only one, card.    The 
following table describes the appropriate conditions when you should double down.



The best time to double down is when you're holding a 9, 10, or 11.    The reason for this is 
that there are quite a few 10 cards in a shoe and you're betting that you'll be dealt one of 
these 10 cards.    However, the table says to refrain from doubling down if the dealer himself 
is showing a high card.    After all, the dealer might have a 10 card as his hole card making 
for a hand that is difficult to beat.

There is also a table that describes when to double down on soft hands.    The following table
describes the appropriate conditions when you should double down.

Note that you should not double down on soft 10's or 11's.    In fact, there is no such animal!  
See,    the lowest soft hand is a soft 12 - an Ace and an Ace.    Also, you should not double 
down on any soft hand greater than 18.    The simple reasoning for this is that these are darn
good hands to stand on.    When you double down on a soft hand, you're hoping that the next
card is small; however, it is impossible to bust even if the next card happens to be large.    
Also note that the best time to double down on a soft hand is when the dealer is showing a 
stiff card (less than 7).    This is due to the fact that the dealer may easily bust; thus, making 
you the winner regardless of what your third card is.

The final table describes when to split a hand.    Remember that it is only possible to 
split if you are holding two cards of equal value.    For this reason the table is 
configured slightly different.    That is, the player's hand is signified by the exact cards
you are holding.



As you can see, you should always split Aces since it is much better to hit the respective 11's
than it is to hit a 12.    Likewise, always split 8's since it is better to hit the respective 8's than
it is to hit a 16.    The table may look random; yet, each split makes sense if you give each 
circumstance a little thought.

The preceding tables assume that at least a four deck shoe is being used.    The 
advice tables do indeed differ slightly for shoes with less than four decks.    For 
instance, the following changes should be made to the preceding tables for a two 
deck shoe:

Double down on a hard 9 against a 2 
Double down on a hard 11 against an Ace 

A single deck shoe has quite a few more modifications to the preceding tables.    The 
following changes should be made to the preceding tables for a single deck shoe:

Stand on a soft 18 against an Ace

Double down on a hard 8 against a 5
Double down on a hard 8 against a 6
Double down on a hard 9 against a 2
Double down on a hard 11 against an Ace

Double down on a soft 13 against a 4
Double down on a soft 14 against a 4
Double down on a soft 17 against a 2

Split a 2, 2 against a 3
Split a 6, 6 against a 2



The Simple Count

The Basic Strategy provides statistically sound advice based upon the likelihood of 
what the next card will be.    However, as cards are dealt from the shoe, the odds that
the next card will be a high card (or low card) fluctuate.    This is simply due to the 
fact that sometimes more high cards are dealt than low cards.    If you're keeping 
track of how many high cards (and in turn, low cards) have been dealt, then you can 
modify your game play to take advantage of the situation.    This is the core concept 
of The Simple Count which was first developed by Edward O. Thorp.

The goal of card counting is to determine if there is an excess of low or high cards 
remaining in the shoe.    To do this, you certainly wouldn't have to count every 2, 3, 4,
and so on.    That would be far too complicated and confusing.    Just use the simple 
scheme of associating a value to each card.    Then, as you see the various cards 
dealt from the shoe, you add the associated values to the running card count.    Here 
is the association table:

The card count starts at 0.    Then for every card that becomes visible, the associated card 
value is added to the running card count.    Now, there is an excess of large cards remaining 
in the shoe if the card count grows in the positive direction.    This is because more small 
cards with a value of 1 have been dealt and counted.    On the other hand, there will be an 
excess of small cards remaining in the shoe if the count grows in a negative direction.    
Again, this is because more large cards with a value of -1 or -2 have been dealt and counted.

A large positive card count is definitely most beneficial to you.    See, the dealer must 
always hit if he has less than 17; even if there is a large positive card count.    You, on 
the other hand, have the prerogative to stand on a hand less than 17 knowing that 
the next card dealt has a high probability of being a ten card.    Since you have the 
advantage on a high card count, you'll want to increase your bet as the card count 
rises.    The table of betting contingencies follows.

For instance, if the shoe contains 4 decks and the card count is less than 8, then you should 
maintain your base bet of 1 unit.    That is, if your initial bet is $5.00, then your base bet is 
$5.00 and you should stick to betting only $5.00.    On the other    hand, if the card count 
rises to 16, then you should up your bet to 2 units ($10.00).    Continuing, if the card count 
rises to 24, then you should up your bet to 3 units ($15.00).    As you can see, fluctuations in 



the card count on smaller shoes will rapidly affect the bet you should wager.    Hence, if you 
know the current card count,    then you can capitalize on the situation based upon this 
knowledge.    This is another benefit of smaller shoe sizes.

Since the Basic Strategy is based on the odds of the next card dealt, the strategy 
should be modified when you have a better idea of what the next card will be.    With 
this in mind, you need to make the following changes to the Basic Strategy with 
regard to the current card count.

Stand on a hard 16 against a 7 or more when the card count is > 0
Stand on a hard 15 against a 7 or more when the card count is > 3
Stand on a hard 14 against a 7 or more when the card count is > 7
Stand on a hard 13 against a 7 or more when the card count is > 11
Stand on a hard 12 against a 7 or more when the card count is > 15

Stand on a hard 12 against a 2 when the card count is > 3
Stand on a hard 12 against a 3 when the card count is > 1

Double down on a hard 11 against an Ace when the card count is > -2
Double down on a hard 11 against a 10 when the card count is > -5
Double down on a hard 11 against a    9 when the card count is > -5

Double down on a hard 10 against a 11 when the card count is > 3
Double down on a hard 10 against a 10 when the card count is > 3

Double down a on hard 9 against a 7 when the card count is >    3
Double down a on hard 9 against a 2 when the card count is > -1

Double down a on hard 8 against a 5 when the card count is > 2
Double down a on hard 8 against a 6 when the card count is > 2

Split a 10,10 against a 4 when the card count is > 5
Split a 10,10 against a 5 when the card count is > 3
Split a 10,10 against a 6 when the card count is > 4

Finally, taking insurance should be discussed.    Some people think that insurance 
should be taken only when you have a good hand.    This is far from the truth.    
Remember, insurance is offered when the dealer has an Ace showing; so, you are 
insuring against a dealer blackjack.    That is, you are insuring against the dealer 
having a 10 as a hole card.    Now, If you know the card count, then you have a good 
idea what the next card will be.    Hence, taking insurance is only contingent upon the
card count.    With this in mind, use the following table of insurance contingencies to 
determine when you should take insurance.

For instance, if the shoe contains 4 decks and the card count is greater than 11, then you 
should take insurance; otherwise, refuse insurance.    This means that you will usually refuse 
insurance.





The Complex Count

Just like the Simple Count improves upon the Basic Strategy, The Complex Count 
improves upon the Simple Count.    A player using this technique makes for a very 
successful player.    Unfortunately, this technique is somewhat difficult to master.    
With this in mind, it is strongly suggested that you first learn the Simple Count before
studying the Complex Count.    

The Complex Count works upon the same principle as the Simple Count in that it 
keeps track of the low and high cards dealt through the mechanism of a single 
number.    Furthermore, this single number, the count, is calculated in the same 
manner - by associating a value with each card, and then adding the associated 
values as the cards become visible.    However, the Complex Count associates 
different values to the cards.    Here is the association table:

As you can see, these values are somewhat more difficult to memorize than those from the 
Simple Count.    Now, you can think of the running sum of the card values as the complex 
count.    However, the adjusted complex count is used for all pertinent decisions.    Here is the
formula for computing the adjusted complex count:

 Adjusted                                                    Count times 100
 Complex  =  -----------------------------------------------
      Count                  number of cards remaining in shoe

The adjusted complex count is then used to determine your bet.    Since the shoe size 
is accounted for in the computing of the adjusted complex count, the bet 
contingencies need not take the shoe size into account.    With this in mind, use the 
following table to determine your bet.

After the bet has been made and the cards have been dealt, you'll need to use the adjusted 
complex count to direct your game play.    The tables are very similar to the Basic Strategy 
tables.    



So, if there is an 'H' in the box, then you should hit.    However, if there is a number in the 
box, then you should hit only if the adjusted complex count is less than the number (stand 
otherwise).    For readability, the positive numbers are colored blue whereas the negative 
numbers are colored red.

The Soft Hit Table is virtually the same as the Basic Strategy.    However, hit a soft 18 against 
a 10 if the adjusted complex count is greater than 15.    Likewise, hit a soft 18 against an Ace
if the count is greater than 2.



So, double down if the box contains a 'D'.    However, if there is a number in the box, then 
only double down if the adjusted complex count is greater than the number in the box.    
Again, the different colors are merely for the readability of positive and negative numbers.

Like the previous tables, Split if there is a 'S' in the box.    However, if there is a number in 
the box, then only split your hand if adjusted complex count is greater than then number in 
the box.

As far as insurance goes, you should insure only if the adjusted complex count is 
greater than 7.




